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1. INTRODUCTION 
 

1.1. Clinical Audit Tool (CAT) 

 

The Clinical Audit Tool (CAT) analyses clinical information from GP Clinical Desktop 

Systems. It translates data into real statistical and graphical information that is easy to 

understand and action. This allows practitioners to assess and improve the quality and 

completeness of patient information. The benefit to the practice is to assist with its ongoing 

accreditation and provide opportunities to grow practice income. The emphasis of the tool 

is to help practice staff to take specific action to improve patient coverage in chronic 

disease management and prevention. 

 

Other benefits of CAT are many and include: 

• targeting patients with particular needs 

• targeting patients with specific health risk profiles 

• improved compliance with statistical data collections 

• extracting data to meet the needs of others 

• meeting reporting requirements 

 

 
Statistics that are required for the Australia Primary Care Collaboratives (APCC) program 
and the DoHA Future Directions Key Performance Indicators for Divisions are a by-product 
of the use of the system. 

 

1.2. User Guide 
 
The purpose of this document is to provide instructions on how to install and use the 
functionality provided by the CAT. 
 

1.3. Notes about this User Guide 

 

This User Guide describes the use of the PCS Clinical Audit Tool with reference to the HCN 

Medical Director, Best Practice and Genie Clinical Desktop Systems.  

 

Wherever Medical Director is used in this document we are referring to the Health 

Communications Network – Medical Director ™ Clinical Desktop System. 

 

Wherever Best Practice is used in the document we are referring to the Clinical Desktop 

System produced by Best Practice Software. 

 

Wherever Genie is referred to we are referring to the Clinical Desktop System produced by 
Genie Solutions. 

 

There are other Clinical Desktop Systems that may interoperate with the PCS Clinical Audit 

Tool in the future and additions will be made to this User Guide when they are available.  
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1.4. Definitions, acronyms and abbreviations  

 

Term Description 

ACR Microalbumin Creatinine Ratio 

APCC Australia Primary Care Collaboratives 

ATSI Aboriginal Torres Strait Islander 

BMI Body Mass Index 

BP Blood Pressure 

CAT Clinical Audit Tool 

CHD Coronary Heart Disease 

COPD Chronic Obstructive Pulmonary Disease 

CV Cardiovascular 

CVD Cardiovascular Disease 

DVA Department Veteran Affairs 

eGFR Estimated Glomerular Filtration Rate 

HbA1c Haemoglobin A1c 

HDL High-density Lipoproteins 

HMR Home Medicine Review 

LDL Low-density Lipoprotein 

MD Medical Director 

NPCC National Primary Care Collaboratives 

PCS Pen Computer Systems 

RACGP Royal Australian College of General Practitioners 

SIP Service Incentive Payment 
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2. SYSTEM REQUIREMENTS 
 

The minimum and recommended system requirements to be able to run the Clinical Audit 

tool are provided in this section. 

 

2.1. Operating System 

 

Clinical Audit runs under the following environments; 

Microsoft Windows VISTA 

Microsoft Windows XP Professional 

Microsoft Windows 2003 Server 

Microsoft Windows 2003 R2 Server 

 

2.2. Microsoft .NET Framework 

 

PCS Clinical Audit requires the Microsoft .NET Framework version 2.0 to be installed prior 

to installing PCS Clinical Audit. This can be downloaded from  

 

http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-

aab15c5e04f5&displaylang=en 
 

 

How to check which version of .NET you have installed: 

 

Method 1: 

Go to Start > Control Panel 

Open ‘Add or Remove Programs’ 

Check to see that ‘Microsoft .NET Framework 2.0’ appears in the list 

 

Method 2: 
Using windows explorer 

 

 

Locate the 

%systemroot%\Microsoft.NET\Framework 

folder 

[The %systemroot% is found under your 

c:\ drive and will usually be named 

‘WINDOWS’ or ‘WINNT’] 

 

The versions that are installed will be 

listed by folder.  

 

 

 

 

2.3. Internet Explorer 

 

To install PCS Clinical Audit you must use Internet Explorer version 5.5 or later. Clinical 

Audit can be installed by going to the following URL 

 

http://www.pencs.com.au/ClickOnce/ClinicalAudit/publish.htm 
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2.4. Internet Connection 

 

PCS Clinical Audit uses an authentication mechanism that requires a persistent internet 

connection. It is recommended that you have a broadband internet connection to operate 

PCS Clinical Audit. 

 

2.5. Memory 

 

Clinical Audit requires at least 196MB of available memory for a typical Clinical Desktop 

System (eg. Medical Director) installation1. It is recommended that you use Clinical Audit 

on a system with at least 512MB of RAM installed. 

 

2.6. Disk Space 

 

The program itself is relatively small; however, each snapshot for a typical Clinical Desktop 

System (eg. Medical Director) installation1 will require around 25MB of disk space. 

 

 

2.7. Clinical Desktop System Compatibility 

 

• Medical Director 

Clinical Audit has been tested against Medical Director Versions 2 and 3. As new 

versions of Medical Director are released, PCS Clinical Audit will be validated and, if 

required, updated to maintain compatibility. 

 

• Best Practice 

Clinical Audit is compatible with Best Practice version 1.6.0.395 and later. As new 

versions of Best Practice are released, PCS Clinical Audit will be validated and, if 

required, updated to maintain compatibility. 

 

• Genie 

Clinical Audit is compatible with Genie Version 7.5.3 and later. As new versions of 

Genie are released, PCS Clinical Audit will be validated and, if required, updated to 

maintain compatibility. 

 

                                                
1 For the purposes of this document a typical Medical Director installation contains approximately 10,000 patient records. 
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2.8. Best Practice Requirements 

 

Best Practice Software provides a new executable file that must exist with your Best 

Practice application in order for Clinical Audit to be able to collect data. If this file is not 

installed you will receive the following error message when you click the Clinical Audit 

‘Collect’ button. 

 

 
 

If you receive this message contact Best Practice Software and they will provide a copy of 

the file for you. It is intended that this file will included in future releases of the application. 

 

 

2.9. Genie Requirements 

 

The Genie software application provides a new Reports menu option that performs the data 
extraction for Clinical Audit. This is described in the Appendices section of this manual. 
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3. INSTALLATION 
 

The Clinical Audit Tool is available using Microsoft ClickOnce technology. 

 

Using Internet Explorer and go to the URL  

 

http://www.pencs.com.au/clickonce/clinicalaudit/publish.htm  

 

Note: ClickOnce technology is not compatible with FireFox. 

 

Click the ‘Install’ button 

 

 
 

The application will be launched. 
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You will be provided with some security information about the application. Click the ‘Install’ 

button to continue with the install. 

 

 
 

A dialog box will display showing you the progress of the install. 

 

 
 
 

Once the install has completed the Clinical Audit Tool Login screen will appear. 
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Account name and Authorisation key – enter the details provided to you. 

License Key – leave this empty unless you have been provided with a special key (a key 

will be automatically generated for you at first login) 

 

Click ‘Ok’ 

 

The first time you login the dialog box below will pop up.  

 

 
 

This lets you know that the folder ‘C:\ClinicalAudit’ on your PC will be used to store the 
‘snap-shots’ of your data for analysis by the Clinical Audit Tool. If you prefer to store them 

somewhere else you can change this by selecting Edit > Preferences from the top menu. 

Setting your preferences is explained in the next section: ‘Setting Your Preferences’. 
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3.1. Installing to a Desktop PC 

 

Clinical Audit needs to be installed under each profile (login) that will be using it on the PC. 

That is, if multiple people log on to the one PC and they each want to use Clinical Audit the 

installation needs to be repeated for each login. The application generally only installs once 

but ‘activates’ itself for the other logins on additional installs. 

 

 

 

3.2. Installing to Terminal Services or Citrix 

 

The only differences to the preceding installation instructions are the following: 

  

1. Clinical Audit needs to be installed on the SERVER 

 

� Log on as the user via a Terminal Services or Citrix session and you will 

automatically be on the server. Follow the installation instructions in the preceding 

section. 

 

2. Clinical Audit needs to be installed under each profile (login) that will be using it. 

That is, if multiple people will be using it, the installation needs to be repeated for 

each login. The application generally only installs once but ‘activates’ itself for the 

other logins on additional installs. 

 

� Log on as each user that will be using CAT and repeat the install instructions. 

 

 
NOTE: If access privileges are an issue, then you will need to elevate the user’s privileges to 

install and then restore them afterwards. This is a Microsoft configuration. 
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3.3. Proxy Servers 

 

If you are having trouble installing the Clinical Audit Tool it may be because you a behind a 

Proxy Server. Some Proxy Servers will prevent you from installing the Clinical Audit Tool 

which uses a very new deployment technology developed by Microsoft. 

 

When attempting to install one of the following may occur 

• you get a message like “the application failed to install” 

• you get a message indicating a “CGI error” 

• you can’t login even though you have the correct user name and password 

 

These problems are most likely caused by your system’s Proxy Server.  

 

If you cannot install the Tool, please contact your Network Administrator or IT support 

person and advise them of this issue. There is a hot-fix supplied by Microsoft that may help 

in allowing installation to occur behind your Proxy Server. 

 

The hot-fix can be downloaded here: 

 

http://www.myhealthepractice.com.au/DOTNETHOTFIX_Proxy_KB917952.zip 

 

If your Network Administrator or IT support contact is unable to help please contact your 

division. 

 

Follow these steps 

1. Logon to the computer you are installing CAT onto as Administrator 
2. Download the zip file and extract the files 

3. Run the extracted .exe file 

4. Reboot the computer 
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3.4. Using Clinical Audit Offline 

 

You must install and login initially to Clinical Audit while connected to the Internet so your 

login details can be validated. 

 

You can then use CAT without being connected to the Internet for a period of 1 month. 

 

When you are connected to the Internet CAT is able to verify your registration credentials are 

still valid and check to see if there are any application updates available for download. 

 

If you use CAT for a long period of time without connecting to the Internet then your 

credentials will eventually expire. You will need to connect again and go to the CAT installation 

URL to download an update. 

 

 

Note: If you have a Desktop Shortcut to CAT and it does not work offline you simply need to 
delete and recreate it. 

 

 
 

3.5. CAT Licence Key 

 

All CAT users are provided with a license key that gives them access to the Clinical Audit 

Core Product (CACP). The CACP includes all the functionality that is described in this manual. 

 

The license key is generated the first time a user logs in by leaving the license key field 

blank. 

 

Custom CAT modules may be developed to meet specific user requirements. License keys 

can be issued to users that provide access to the CACP and the required additional modules.  

 

The license key is updated by entering the new issued license key at the login screen or in 
the preferences screen. 
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4. CAT USER INTERFACE 
 

Once the CAT software has been installed it is available from your Programs List. 

 

Click Start > All Programs > Pen Computer Systems > PCS Clinical Audit 

 

Enter your Account name and Authorisation key and click ‘OK’. 

 

Once you have logged in the screen below will display. You will see the population figure is 

initially 0 because you have not yet collected data from your clinical desktop system. 
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4.1. Setting Your Preferences 

 

Your Preferences are set by selecting Edit > Preferences from the top menu. 

 

 
 

 

The Preferences Dialog box will be displayed. 

 

 
 

 

GP Application 
From the drop down list select the Clinical Desktop System you wish to collect from. 

Then click the tab for that Clinical Desktop System to enter further values. 

 

Practice Name and Practice ID Number 

Fill in the values for these fields with your practice details. At a future time these values 

will be used if your practice decides to participate in projects that send consented, de-

identified patient clinical data to your Division or other data repository. 

 

Extract Directory 

This folder is used to store the ‘snap-shots’ of your data for analysis by the Clinical Audit 

Tool. By default the data will be stored in the folder ‘C:\ClinicalAudit’ on your PC. If you 

prefer to store them somewhere else you can change this by clicking the ‘Browse’ button 

and choosing another Data Folder Location. Click ‘OK’ when you have selected a new 
location. Click ‘OK’ to save this location and close the Dialog box. 

 

License Key 

The license key contains details of the modules in CAT you have access to. All users have 

access to all the functionality described in this manual. 

You should not change the license key unless you are specifically provided with a new one 

by PCS. 
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4.1.1. Choosing your Clinical Desktop System 
 

Once you have selected your Clinical Desktop System from the ‘Clinical Audit’ tab, click the 

tab for that Clinical Desktop System to enter further values. 

 

Medical Director 2 

Click the browse button to locate the database directory. 

 

 
 

Medical Director 3 

Select your database configuration from the drop-down list. These will match the 

configurations you have available through the ‘HCN Maintenance’ icon on your desktop. 
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Best Practice 

Select either ‘Live Data’ or ‘Sample Data’ from the drop down list. 

 

 
 

Genie 
There is no further set up for Genie.  

The Genie software application itself provides a new Reports menu option that performs the 

data extraction for Clinical Audit. This is described Appendices section of this manual.  

The Genie preference tab summarises the steps you should follow. 

Ensure the Extract Directory on the ‘Clinical Audit’ tab matches the extract folder chosen in 

Genie. 
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Once you have selected your Clinical Desktop system the details will be displayed above the 

row of tabs. 

 

Clinical Desktop System        Database Location 

 

 

 
 

 

 

4.1.2. Choosing a preferred Data Folder Location 
 

If there are a few clinicians in the practice that are using CAT then choose a network 
drive that is accessible to all.  

Use the ‘Edit > Preferences’ option to set the same ‘Data Folder Location’ for each user. 

 

More than 1 user can work with the same snapshot at the same time. 

 

 

 

Genie users will need to make sure this folder matches the folder they select from the 
Genie application when they do the extract. 

This is described in the Appendices section of this manual. 

 

 

 

 

4.1.3. Changing the Licence Key 
 

You should not change the license key unless you are specifically provided with a new one 

by PCS.  

The license key is updated by clearing the license key field and pasting the new one you 

have been issued into the field. 
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4.2. Navigating the CAT User Interface 

 

Click the ‘View Extracts’ and the ‘View Filter’ buttons to display all the areas of the CAT 

user interface. 

 

The screen is divided into 3 sections: 

• Data Snap-shots (or Extracts) collected for analysis (Left Hand Panel) 

• Data Filters (Top Right Panel) 

• Data Reports (Bottom Right Panel) 

 

It is handy to be able to hide the data collection and data filter areas of the screen in order 

to make best use of your screen space to view the data results. You can toggle between 

the View/Hide modes at any time.  
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5. COLLECTING DATA SETS 
 

NOTE:  

Before you start collecting data sets ensure you have set up your preferences to point to the 

correct clinical desktop system for your practice. (See ‘Setting Your Preferences’ for details 

about how to do this.) 

 

 

A data set is collected by clicking the ‘Collect’ button at the top left of the screen.  

 

Once you click the ‘Collect’ button you will see the ‘status bar’ in the top right hand corner of 

the screen flashing while the data is retrieved from the clinical desktop system. 

 

• Genie users please note that the data collection is performed from within the 

Genie application. Clicking the CAT ‘Collect’ button at the top left of the 

screen will provide you with the summary steps on how this is done within 

Genie. Step by step details are provided in the Appendices. 

 

The data set collected is saved in your preferred data folder (see ‘Setting Your Preferences’ 

for more information). 

 

When the data retrieval has completed you will see an entry in the left hand column. The 

data is stored as a ‘snap-shot’ on your PC. You can use this ‘snap-shot’ for analysis at any 

time in the future. 

 

 

Tip: To refresh the list of ‘snap-shots’ click Edit > Preferences and click ‘OK’. 
 

 

 
‘Collect’ button                         Status bar 

 

 

 

 
 

 

 

 

Data set snap-shot 
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Each entry displays the date/time of collection, the number of records retrieved and the 

machine name on which the collection was done. 

 

You can collect as many data sets as you wish over time. Each data set will be listed as an 

entry in the left hand column. 

 

To analyse a specific data set click on the entry for that data set. It will become highlighted 

and you will see the ‘status bar’ in the top right hand corner of the screen flashing while 

the data is reloaded from the ‘snap-shot’ into Clinical Audit. 

 

 

5.1. What data is collected 

 

Data is only collected for patients who are active in your Clinical system. Data for 

patients who are deceased or have been made inactive is not collected. 

 

This means when you are analysing your data using CAT you are only seeing patients who 

are currently marked as active in your Clinical system. You may find patients in CAT that 

you know are no longer active at your practice. If you inactivate them in your Clinical 

system they will be excluded from future data collections. 
 

 

5.2. How is the data stored 

 

The collect saves 2 xml data files to your preferred data folder. One file is pure Clinical data 

and has no identifiable patient information. This is called the DATA file. The other file is the 

LINK file and contains all the patient identifiable data. The LINK file is only used when you 

want to re-identify a list of patients that make up a segment of a graph. 

 

In your preferred data folder the files look like this: 

 

 
 

 

5.3. Existing data set compatibility with changes to CAT 

 

CAT version 2 has new filters and reports. Additional data is collected by version 2 for 

these new functions. Your CAT version 1 extracts will not have the additional data needed 

to make these functions work.  

 

You can load up your version 1 extracts and analyse them as before - the new functionality 

will inactivated for these extracts by being greyed out.  
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6. DATA FILTERING 
 
6.1. Data Filtering Overview 

 

Data can be filtered so that you can view graphs and reports for specific criteria. 

 

The data filters are organised into a series of tabs: 

• General (Demographics)  

• Conditions (Medical)  

• Medications  

• Results 

• Providers 

 

Another tab is provided for you to save your selected filter criteria: 

• Saved Filters 

 

To filter the data simply select the criteria you require to look at. This is usually done by 

ticking selection boxes. The criteria you have selected will be displayed at the top of the 

Results panel. They will be displayed even if you hide the filter panel. 

 
Click ‘Recalculate’. You will see the ‘status bar’ in the top right hand corner of the screen 

flashing while the filtered data is reloaded from the ‘snap-shot’ into Clinical Audit. This will 

limit your data to look at only patients that match all the conditions ticked.  

 

 

Example: 

‘Filter By’ displays the criteria selected (eg. Male, Diabetes Type II, Aspirin) 

 

 
 

 

 

Examples for each of the filter types are provided in the following sections. 
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6.2. Changing Filters 

 

When you make changes to the filters the new selections do not become effective in the 

Reports until you have clicked the ‘Recalculate’ button.  

 

• The ‘Recalculate’ button will turn red when the filter text has changed but the 

button has not been clicked 

 
 

• If the ‘Recalculate’ button has not be clicked the correct previous filter text will 

display on any printed graphs and reports 

 

 

6.3. Clearing Filters 

 

To clear filters that have been selected either:  

 
• Click the ‘Clear Filters’ button in the top right hand corner of the screen to clear all 

your filters.  

 

The ‘Clear Filters’ dialogue box will appear.  

Note: This dialogue box is also used to clear any Report Selections that have been 

made. Refer to the ‘Cross Tabulation Report’ for details on this functionality. 

 

The ‘Clear all Filter Selections’ will be pre-ticked. Click ‘OK’ to continue. 

 

  
 

 

• Click the ‘Clear …’ button at the bottom right hand corner of each tab to clear only 

the filters for that tab. 

 

 

 NOTE: 

Make sure you click ‘Recalculate’ when you have changed the filters.  
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6.4. Demographic Filtering 

 

 

 
 

Patient data can be filtered as follows: 

 

Gender Male  
Female 

Other 

No selection = All 

 

Note: Ticking multiple boxes will create an OR criteria ie. Male OR Female. 

  

Ethnicity ATSI (Aboriginal Torres Strait Islander) 

non ATSI 

No selection = All 

 

Note: Ticking multiple boxes will create an OR criteria ie. ATSI OR non ATSI 

  

DVA DVA (Department Veteran Affairs) 
non DVA 

No selection = All 

 

Note: Ticking multiple boxes will create an OR criteria ie. DVA OR non DVA 

  

Age Enter a numeric start age or end age to limit your selection 
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Last Visit The last visit date is the most recent date a patient contact has been 

recorded.  
 

In Medical Director this is deemed to be the date of the most recent progress 

note. Check the ‘General Data Mappings’ Appendices for each Clinical system. 

 

 Values for selection are: 

• Any = the last visit was at any time (all patients will be selected) 

• Active = has had 3 visits in the last 2 years (RACGP definition)  

• Not Active = a patient not meeting the RACGP definition of active 

• <15 mths = has visited in the last 15 months 

• <30 mths = has visited in the last 30 months 

• Date Range with from/to date selection = patients whose most recent 

visit occurred within a period of time 

 
The ‘Date Range’ filter – to note: 

The ‘Date Range’ filter cannot be used to retrospectively look at the data in a 

‘snap-shot’. The ‘snap-shot’ is only valid for the point in time at which it was 

taken. 

 

For example: If you filter on last visit between 1 and 2 years ago you will be 

excluding patients you have had a visit more recently. These patients may or 

may not have had a visit in the period of time you are selecting. You will not 

be selecting all patients who visited within that period. 

  

Postcode Enter a 4 digit postcode or 

Multiple postcodes can be entered separated by a comma 

 

This filter allows you to select whether the list of postcodes is for 

• Include in the filter  

Patients matching a postcode in the list will be selected 

• Exclude from the filter 

Patients matching a postcode will not be selected 

 

The Exclude option allows practices to find patients that do not reside in their 

local area and may be transient. 

 

 

6.4.1. Demographic Filter Mappings with Clinical systems 
 

The demographic filter mappings are provided in the ‘General Data Mappings’ Appendices 
for each Clinical system. 
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6.5. Medical Conditions Filtering 

 

 
 

Selecting Conditions by ticking the boxes will limit your data to look at only patients that 

match all the conditions ticked:  

 

Condition – Yes , No , no selection = All 

 

You can select to filter by patients that 

• Have a condition (tick the Yes box) 

• Do not have a condition (tick the No box) 

 

If you tick one of the main condition headings (bolded) the sub-heading selections will not 

be available and all patients matching that broad condition will be selected. 

 

 

6.5.1. Pregnancy 
 

Pregnancy is included under the conditions filter. Ticking this as ‘Yes’ will give you a list of 

the patients who are currently flagged as pregnant in the Clinical System. Check the 

appendix for your Clinical system for details about how this is checked. 

 

 

6.5.2. Medical Conditions Filter Mappings with Clinical systems 
 

The conditions filter mappings are provided in the ‘Conditions Data Mappings’ Appendices 

for each Clinical system. 

 

Note that some conditions are flagged as true for a patient if the patient has ever had the 

condition ie. the condition forms part of the patient history but is not currently listed as 
active (eg. heart disease). Check the appendix for your Clinical system for details about 

how different conditions are collected. 
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6.6. Medications Filtering 

 

Medications are divided into 2 tabs to allow for a greater number of medications to be 

selected. These are 

• Medications – Heart 

• Medications – Other 

 

 
 

 
 

 

Selecting Medications by ticking the boxes Yes or No will limit your data to look at only 

patients that match the medication status selected: 

 

Medication – Yes , No , no selection = All 

 

 

 

6.6.1. Medications Filter Mappings with Clinical systems 
 

The medications filter mappings are provided in the ‘Medications Data Mappings’ 

Appendices for each Clinical system. 

 

Medications are flagged as true if they are on the patient’s current medication list. The 

collection process does not make any decisions about whether a medication should actually 

have been removed from the current medication list. The GP is responsible for making sure 

the list of medications is accurate. 

 

 



   

 

 Version 2.3 PEN COMPUTER SYSTEMS PTY LTD Page 31 of 110 

 

PCS CLINICAL AUDIT TOOL – USER GUIDE 
 

6.7. Results Filtering 

 

 
 

This filter allows the user to view the last recorded result that falls within a specified time 

period or date range. 

 

By selecting a date range of 

• <= 6mths 

• <=12 mths 

• <=24 mths 

• User defined range 

the user can filter out results that have not been measured within the selected period.  
 

Results outside the selected period are treated as ‘Not recorded’. 

 

This will give a more meaningful picture for charts like HbA1c where old results are really 

not relevant. 

 

The filter is only applicable to some charts. Where the filter has been applied the chart title 

will include the selected period.  

For example, 
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6.8. Provider Filtering 

 

The provider filter allows you to filter patients by provider. This allows providers within 

your practice to drill down to their own patients. 

 

The provider filter tab displays a list of the practice clinicians with a provider number. You 

can filter by 

• Practice – all providers are ticked 

• One or more providers – tick those you wish to filter on and un-tick the ‘No 

Assigned Provider’ box 

• No Assigned Provider – to find patients that are not assigned to any provider 

 

 

 
 

 

 

6.8.1. Method of assigning a patient to a provider 
 

Medical Director 

 

Where there is more than one provider in the practice, patients will be assigned to a 

particular provider based on which provider they were most frequently seen by in recent 

consultations. 

 

Patients will be assigned to the provider who saw them for the highest number of 

consultations in the previous 18 months.  

Where there is no consultation recorded in the previous 18 months, the patient will be 

assigned to the provider who saw them most recently, up to 5 years ago. 

Where there is no consultation recorded in the previous 5 years, no provider will be 

assigned. 
 

Genie 

 

Genie will use the ‘Usual Provider’ that is entered on the patient details screen. 
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6.9. Saving Filter Criteria 

 

The ‘Saved Filters’ tab allows a set of filter criteria to be saved as a named search. Saved 

search names can be reloaded at a later time and run. This gives the ability for practices to 

run the same filters over intervals of time and compare results. 

 

 
 

 

 

 

6.9.1. Creating a New Filter Name 
 

Initially the ‘Saved Filters’ tab will be empty. To create a filter: 

 

• Select some filter options eg. Active Patient with Diabetes 

• The ‘Save New Filter’ button will become available 

 

 
 

• Click the ‘Save New Filter’ button 

• The ‘Filter Details’ dialogue box will open 
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• The filter options you have selected will be shown in the filter Description 

 

 
 

• Fill in the ‘Filter Name’ 
 

 
 
 

• Click ‘OK’ 

• The new filter name will now be listed on the ‘Saved Filters’ tab 

 

 
 

 

 

 

The filter name can be changed using the ‘Edit’ button. 

The filter can be deleted using the ‘Delete’ button. 
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6.9.2. Loading existing filters 
 

 
 

To load a saved filter 

• Click the ‘Saved Filters’ tab 

• Click on the filter name required 

• The filter details will be loaded into the other filter tabs and will display at the top 

of the Results panel 

• The ‘Recalculate button will turn red 
 

 

 
 

 

Click the ‘Recalculate’ button
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7. ANALYSING A DATA SET 
 

7.1. Data Set Results Overview 

 

Once you have selected your data set snap-shot and your data filters click ‘Recalculate’. 

You will see the ‘status bar’ in the top right hand corner of the screen flashing while the 

filtered data is reloaded from the ‘snap-shot’ into Clinical Audit. Once this has finished you 

are ready to work with the data set of patients that match all the conditions selected.  

 

The data set for this exercise has 11796 patients and has been filtered on Gender = 
Female and Condition = Asthma. 204 patients have been returned matching the filter. 

 

Example: 

Total Patients , Filter , Selected Patients 
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Click the ‘View Pop.’ button at the top of the screen to get a list of the patients that have 

been selected in this dataset. (Note this is the filtered dataset not the full dataset.) 

 

 
 

 

This will pop up a list of patient details. Use the  ‘Export’ menu option to export the data 

to Excel format for follow up, if required. 

 

The far right column on the Population list will show you the patients last visit date. 
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7.2. Data Set Results Graphs and Reports 

 

Click the ‘Hide Extracts’ and ‘Hide Filter’ buttons to maximise the use of your screen for 

viewing results. 

 

 

The tabs along the top of the results panel allow you to view various graphical 

representations of your data set. 

 

 

 
 

 

These are  

• Demographics 

• Allergies 

• Smoking  

• BMI (Body Mass Index) 

• Disease  

• Pap Smear  

• Lipids (includes Cholesterol, HDL, LDL, Triglycerides, Total Chol/HDL Ratio) 
• Creatinine (includes ACR, eGFR) 

• HBA1c 

• BP (Blood Pressure) 

• Medications  

• Diabetes SIP (Service Incentive Payment) Items 

• CV (Cardiovascular) Event Risk 

• HMR (Home Medicine Review) 

• Immunisations (includes Influenza, Pneumococcal, Gardasil, Pertussis) 

• Standard Reports 

o NPCC (National Primary Care Collaboratives) Report 

o NPI (National Performance Indicators) 

o Data Summary Report Card 

 

All views are of your filtered data set not your full data set except for the NPCC and NPI 

Reports.  

 

The NPCC and NPI Reports are always derived from your full data set.  

The NPCC report will always show the practice total number of Diabetes and CHD patients. 

 

Some views are automatically filtered further to suit the data being represented.  

These are 

• Pap Smear – filters out gender=male 

• CV Event Risk – filters out age<20, age>79, ethnicity=ATSI, condition=Diabetic, 

condition=Cardiovascular disease (CVD) 

• Immunisations > Gardasil – filters out gender=male and age<9 



   

 

 Version 2.3 PEN COMPUTER SYSTEMS PTY LTD Page 39 of 110 

 

PCS CLINICAL AUDIT TOOL – USER GUIDE 
 

 

7.2.1. Demographics 
 

Demographics displays your data set as a breakdown of males and females. The data is 

displayed as a graph of the number of patients per age group. 

 

 
 

 

Show Total Counts checkbox – click this checkbox to display the count in each group. 

 

 
 

 

Age Bracket selection box – this allows you to select an age bracket value between 1 and 

10 years. The default value is 5 which displays ages grouped from 0-4, 5-9 etc. Changing 
this value, for example to 10, would display as below. Note that you must click the 

‘Recalculate’ button for the new age bracket to be displayed. 
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Export button – if you click on any segment of the bar chart it will become highlighted and 

the ‘Export’ button in the right hand corner of the results panel will become active. You can 

select more than one segment of the graph. 

 

 

Highlighted segment(s) of bar chart               Export button active 

 

 
 

Click the ‘Export’ button to get a list of the patients that make up this group. (This works 

the same way as the ‘View Pop.’ button except that you not looking at the filtered 

population but are drilling down to a subset of it.) 

 

 
 

This will pop up a list of patient details. The specific age value for each patient in the group 

selected will be provided in the last column. 

Use the  ‘Export’ menu option to export the data to Excel format for follow up, if 

required. 

 
Print button – click the ‘Print’ button to print a copy of the graph. 
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7.2.1.1. Reidentify Report 
 

The reidentify report allows you to identify a list of patient that make up 

• the filtered population 

• a segment of a pie or bar chart 

 

The last column of the report will give you information specific to the graph you are looking 

at, for example: 

• population list will show you the patient last visit date 

• demographics graph will show you age 

• BMI graph will show you the BMI value 

 

The ‘Refine Selection’ button lets you remove patients from the reidentified list for printing 

purposes. This is helpful if you wish to target a small number of patients for follow up and 

only wish to print those you are targeting. 

 

� Click the ‘Refine Selection’ button 

� From the pop-up list of patients untick those you do not wish to target 

� Click OK 

 

Refine Selection button 
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7.2.2. Allergies 
 

Allergies displays your data as a breakdown of allergy status: Allergy Recorded, No Known 

Allergies, Nothing Recorded. The data is displayed as a pie chart. 

 

The patient count in each allergy status group is displayed for each segment of the pie 

chart. 

 

 
 

Show Percentage checkbox – click this checkbox to display the percentage in each group 

rather than the count. 

 

 
 

Uncheck this checkbox to display count. 

 

 

Export button – if you click on any segment of the pie chart it will become highlighted and 

the ‘Export’ button in the right hand corner of the results panel will become active. You can 

select more than one segment of the pie. 
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Highlighted segment of pie chart               Export button active 

 

 
 

 

Click the ‘Export’ button to get a list of the patients that make up this group. (This works 

the same way as the ‘View Pop.’ button except that you not looking at the filtered 
population but are drilling down to a subset of it.) 
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This will pop up a list of patient details. The specific allergy value for each patient in the 
group selected will be provided in the last column. 

Use the  ‘Export’ menu option to export the data to Excel format for follow up, if 

required. 

 
Print button – click the ‘Print’ button to print a copy of the graph. 

 

 

 

7.2.2.1. Allergies Mappings with Clinical systems 
 

The allergies mappings are provided in the ‘General Data Mappings’ Appendices for each 

Clinical system. 

 

 

 

 

 

7.2.3. Smoking 
 

Smoking displays your data as a breakdown of smoking status: Daily Smoker, Irregular 

Smoker, Ex Smoker, Never Smoked, Nothing Recorded. The data is displayed as a pie 

chart. Functions available are as described for Allergies. 

 

 

7.2.3.1. Smoking Mappings with Clinical systems 
 

The smoking mappings are provided in the ‘General Data Mappings’ Appendices for each 

Clinical system. 
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7.2.4. BMI  
 

BMI displays your data as a breakdown of BMI status: Morbid Obesity (40+),  

Obese(30 to 40), Overweight(25 to 29.9), Healthy(18.5 to 24.9), Underweight(<18.5).  

The data is displayed as 

• Count per age range in a bar chart 

• Average BMI per age range in a bar chart with the healthy range indicated  

• Incomplete – where either of height, weight or height/weight are missing so BMI 

cannot be calculated 

 

The ‘Count’ on the Count graph will show you the total of the patients graphed – this is the 

total number of patients where BMI has been able to be calculated. 

 

 
 

Age Bracket selection box – this allows you to select an age bracket value between 1 and 

10 years. The default value is 5 which displays ages grouped from 0-4, 5-9 etc. Changing 

this value, for example to 10, would display as below. Note that you must click the 

‘Recalculate’ button for the new age bracket to be displayed. 
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Export button – if you click on any segment of the bar chart it will become highlighted and 

the ‘Export’ button in the right hand corner of the results panel will become active. You can 

select more than one segment of the graph. 

 

Highlighted segment of bar chart               Export button active 

 

 
 

Click the ‘Export’ button to get a list of the patients that make up this group. (This works 

the same way as the ‘View Pop.’ button except that you not looking at the filtered 

population but are drilling down to a subset of it.) 
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This will pop up a list of patient details with their BMI value. Use the  ‘Export’ menu 

option to export the data to Excel format for follow up, if required. 

Print button – click the ‘Print’ button to print a copy of the graph. 

 

 

 

 

7.2.4.1. BMI Mappings with Clinical systems 
 

The BMI mappings are provided in the ‘General Data Mappings’ Appendices under 

Measurements for each Clinical system. 
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7.2.5. Disease 
 

Disease is displayed as a count (the number of patients that have the disease) and the 

prevalence in the population.  

 

The Disease Prevalence is calculated by identifying the number of patients with a specific 

disease diagnosis and expressing it as a percentage of the total population.  

 

The disease categories are the same as the conditions provided in the conditions filter. The 

data is displayed as: 

• Count per condition in a bar chart 

• Prevalence per condition as a percentage of this population in a bar chart 

 

A bar is also provided on the chart for patients that have ‘None of these’ disease 

categories. This is provided to assist practices in targeting patients for preventative care 

and miscoding. 

 

 

 
 

 

Export button functions as described for BMI. 

 

Print button – click the ‘Print’ button to print a copy of the graph. 
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7.2.5.1. Disease Mappings with Clinical systems 
 

The conditions (disease) mappings are provided in the ‘Conditions Data Mappings’ 

Appendices for each Clinical system. 

 

Note that some conditions are flagged as true for a patient if the patient has ever had the 

condition ie. the condition forms part of the patient history but is not currently listed as 

active (eg. heart disease). Check the appendix for your Clinical system for details about 

how different conditions are collected. 

 

 

 

7.2.6. Pap Smear 
 

The pap smear tab automatically filters out the male population. The population figure 

displayed on this tab is the number patients in your filtered dataset with gender female or 

other. 

 

Pap Smear displays your data as a breakdown of: 

• Pap Smear Recorded: Pap Smear Recorded, No Pap Smear Recorded, Ineligible.  

• Pap Smear Done Date (where Pap Smear Recorded): <1yr, 1-2yrs, 2-3yrs, 3-4yrs, 

>4yrs  

 

The category of ‘Ineligible’ includes: 

Medical Director - all patients who have a hysterectomy condition recorded. 

Best Practice – all patients with tick-box ‘Not Required’ checked 
Genie – all patients marked don’t recall 

 

The data is displayed as a pie chart. Functions available are as described for Allergies. 

 

7.2.6.1. Pap Smear Mappings with Clinical systems 
 

The pap smear mappings are provided in the ‘General Data Mappings’ Appendices for each 

Clinical application. 
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7.2.7. Lipids 
 

Lipids displays your data as a breakdown of: 

 

• Cholesterol: <4.0, >4.0 and <=5.5, >5.5 and <=6.5, >6.5 and <=7.5, >7.5, No 

Cholesterol Recorded. 

 

• HDL: <1.0, >1.0 and <=2.0, >2.0, No HDL Recorded 

 

• LDL: <2.5, >2.5 and <=4.0, >4.0, No LDL Recorded 

 

• Triglycerides: <2.0, >2.0 and <=4.0, >4.0, No Triglycerides Recorded 

 

• Total Chol/HDL Ratio: <3.5, >3.5 and <5.0, >5.0, No Total Chol/HDL Ratio 

Recorded 

 

The data is displayed as a pie chart. Functions available are as described for Allergies. 

 

7.2.7.1. Lipids Mappings with Clinical systems 
 

The lipids mappings are provided in the ‘General Data Mappings’ Appendices under 

Measurements for each Clinical application. 

 

If there are results for Cholesterol, HDL, LDL and/or Triglycerides then the most recent 

values will be displayed. If there are results for HDL and cholesterol is recorded the most 

recent values will be used by CAT to display the Chol/HDL ratio.   
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7.2.8. Creatinine 
 

Creatinine displays your data as a breakdown of: 

 

• ACR (Microalbumin Creatinine Ratio: <=3.5 (Normal), >3.5 (Abnormal), No 

Microalbumin, No Creatinine, No Data 

 

ACR (mg/mmol) is calculated from Microalbumin and Creatinine. The formula is 

 

  microalbumin mg/L 

  -------------------- 

creatinine mmol/L 

 

 

• eGFR (Estimated Glomerular Filtration Rate):  

>100 = Normal 

60-100mg/ml = Stage 1  

30-60 mg/ml = Stage 2  

15-30mg/ml = Stage 3  

<=15mg/ml = Stage 4  

No Data 

 

eGFR (ml/min) is calculated using the CockCroft-Gault formula from Creatinine 

measurement, weight and age. This formula is 

 

(140 – age) X weight Kg x Constant 
--------------------------------------- 

             creatinine µmol/L 

 

Constant = 1.23 for males, 1.04 for females 

 

 

 

The data is displayed as a pie chart. Functions available are as described for Allergies. 

 

 

7.2.8.1. Creatinine Mappings with Clinical systems 
 

The creatinine mappings are provided in the ‘General Data Mappings’ Appendices under 

Measurements for each Clinical application. 

 

If there are results for creatinine and weight is recorded the most recent values will be 

used by CAT to calculate the eGFR.  
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7.2.9. HBA1c 
 

HBA1c displays your data as a breakdown of HBA1c status: <=7%, >7% and <=8%, >8% 

and <10%, >=10%, No HBA1c Recorded. The data is displayed as a pie chart. Functions 

available are as described for Allergies. 

 

7.2.9.1. HbA1c Mappings with Clinical systems 
 

The HbA1c mappings are provided in the ‘General Data Mappings’ Appendices under 

Measurements for each Clinical application. 

 

 

7.2.10. BP  

 

BP displays your data as a breakdown of BP status: <=130/80, 130/80-140/90, >140/90, 

No BP Recorded. The data is displayed as a pie chart. Functions available are as described 

for Allergies. 

 

A patient’s BP must have both systolic and diastolic values recorded on the same day to be 

valid. The most recent recording is used. If only one value is recorded this will be invalid 

and display in the ‘No BP Recorded’ category. 

 

A patient’s BP will be shown in the higher segment if either of the systolic or diastolic 

values is above the cut-off. Eg. a BP of 141/85 will end up in the >140/90 category. 

 

 

7.2.10.1. BP Mappings with Clinical systems 
The BP mappings are provided in the ‘General Data Mappings’ Appendices under 

Measurements for each Clinical application. 

 

 

7.2.11. Medications 

 

Medications displays your data as a breakdown of medication groups. These are the same 

medication groups as provided in the medications filter. The data is displayed as: 

• Count per condition in a bar chart 

• Prevalence per condition as a percentage of this population in a bar chart 

Functions available are as described for Disease. 

 

A bar is also provided on the chart for patients that have ‘None of these’ disease 

categories. This is provided to assist practices in targeting patients for preventative care 

and miscoding. 

 

 

7.2.11.1. Medications Mappings with Clinical systems 
 

The medications mappings are provided in the ‘Medications Data Mappings’ Appendices for 

each Clinical application. 

 

Medications are flagged as true if they are on the patient’s current medication list. The 

collection process does not make any decisions about whether a medication should actually 

have been removed from the current medication list. The GP is responsible for making sure 

the list of medications is accurate. 
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7.2.12. Diabetes SIP (Service Incentive Payment) Items 

 

 

The Diabetes SIP graph is not automatically filtered by the patients with Diabetes. 

To review your Diabetes SIP items you need to first filter on Condition = Diabetes. 

The filtering is not done automatically as some of the items may be of interest for 

the wider patient population eg. CHD patients who have not had a BP in the past 6 mths. 

 

 

Diabetes SIP displays your data as a breakdown of diabetes care items:  

HbA1c,  
Eye Exam,  

BMI < 6mths, BMI 6-12 mths, 

BP < 6mths, BP 6-12 mths, 

Foot Exam < 6mths, Foot Exam 6-12 mths,  

Cholesterol,  

Triglycerides,  

HDL,  

Microalbuminuria, 

Smoking.  

 

The data is displayed as: 

• Count of Patients with Care Item Recorded in the Last x Months 

• Count of Patients with No Care Item Recorded in the Last x Months  
(ie. Items Remaining) 

•  Count of Items Completed per Patient 

 

where x is the number of months within which an item is required to be recorded (6, 12 or 

24 months) 

 

 
 

 

 NOTE:  

Old Extract files did not contain data for BMI, BP and Foot Exam recorded in the last 6-12 

months. Where these are loaded CAT will display a message to alert the user that the 

extract file they are viewing does not contain the data elements in the last 6-12mths. The 

bar segments of the chart for these data elements will always be empty and show 0. 
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7.2.12.1. Cycle of Care by Item 
 

The ‘Items Recorded’ and ‘Items Remaining’ graphs will help you to identify by item the 

areas of care that still need to be recorded for a patient. 

 

Export button functions as described for BMI. 

Print button – click the ‘Print’ button to print a copy of the graph. 

 

 

7.2.12.2. Cycle of Care by Patient 
 

The ‘Items Completed per Patient’ graph provides a view by patients of items that have 

been completed or not. 

 

The ‘Export’ button is renamed ‘Worksheet’ for this graph as it gives a different style of  

re-identify report.  

 

 
 

 

Click the ‘Worksheet’ button to get a list of the patients in any segment(s) of the graph and 

view the list as a Diabetes SIP Worksheet. 

 

Print button – click the ‘Print’ button to print a copy of the graph. 
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7.2.12.3. The Diabetes SIP Worksheet 
 

 
 

 

The worksheet shows a ● in the column of each item which has been completed for a 

patient. 

In this example we have picked patients that have 9 items completed. 

 

 
 

 
NOTE: 

Old Extract Files will only have a possible maximum of 10 items counted. BMI, BP and Foot 

items in the last 6-12mths have not been collected. 
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When claiming a SIP payment you should always check all requirements have 

been met in your clinical software system. 

 

 

 

 

 

7.2.12.4. Diabetes SIP Mappings with Clinical systems 
 

The Diabetes SIP mappings are provided in the ‘Diabetes SIP Data Mappings’ Appendices 

for each Clinical application. 
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7.2.13. CV (Cardiovascular) Event Risk 

 

The CV Event Risk graph displays your data as the % risk of a Cardiovascular Event in 10 

years time. It is a guide only based on population health statistics and is useful for 

clinicians to gain a high level view of patients who are at risk for surveillance. 

 

It is derived from the Cardiovascular Risk Calculator which was published in The Journal of 

the American Medical Association (JAMA) in the May 16 2001 Edition. The calculation uses 

the Framingham Point Score contained in the National Cholesterol Education Program 

(http://www.nhlbi.nih.gov/guidelines/cholesterol) Adult Treatment Panel III Report.  

 

Framingham risk scoring provides a method of patient risk assessment by weighting major 

risk factors and estimating a 10-Year Cardiovascular Risk as a %.  

 

It excludes patients who have: 

 

• Age: <20 or >79 

• Ethnicity: ATSI 2 

• Condition: Diabetic or CVD 3  

 

The data items used in the calculation are: 

 

• Gender  

• Smoking Status (Smoker/Non-smoker) 

• Cholesterol (Mg/dL) 4 

• HDL (Mg/dL) [  
• Systolic BP (mm Hg) 

• Systolic BP being treated 5 

 

 

 

 

 

                                                
2 Ethnic groups may have a differing risk of cardiovascular disease (CVD) at the same level of risk 

factors. The JAMA publication mentions the existence of limited data supporting a variation and a 

British study (http://www.epi.bris.ac.uk/CVDethrisk/) has found a variation for ethnic groups within 

Britain. This calculator does not adjust for ethnic group. 

 
3 CVD includes the CAT Cardiovascular Conditions CHD, Heart Failure and Stroke. 

 
4 CAT captures Cholesterol and HDL in mmol/L which is converted to Mg/dL :  

  1 Mg/dL = 39 X 1 mmol/L 

 
5 Treatment is determined by examining the medication a patient is on. CAT collect data for the 

following medication categories that are prescribed for BP: ACE Inhibitors, A2 Blockers, Beta-blockers, 

Calcium Antagonists and Diuretics. If a patient is on one of these they are considered as being 

treated. 
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CV Event Risk displays your data as a breakdown of the % 10 Year Risk of a Cardiovascular 

Event: >=20%, 15-19%, 10-14%, 5-9% and <5%. The data is displayed as 

• Count per age range in a bar chart 

 

The graph provides a total population number (the filtered population) and an eligible 

population number. 

 

The eligible population is the number of patients in your filtered dataset that can be 

assessed for risk ie. patients that do not fall into one of the excluded groups. 

 

The ‘Count’ on the Count graph will show you the total of the patients graphed – this is the 

total number of patients where CV Event Risk has been able to be calculated.  

 

The eligible population – total count = patients with incomplete data where no risk can be 

calculated. These patients are displayed on the second tab. 

 

 
 

Export button functions are as described for BMI: by selecting the high risk sections of the 

bar chart and clicking the ‘Export’ button a list of the patients that make up this group can 
be obtained. This provides valuable information for practice staff working to improve 

chronic disease management and prevention. The information can also, for example, be 

used to substantiate the 45-49 year old health check. 

Print button – click the ‘Print’ button to print a copy of the graph. 
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Within the eligible population a patient may have incomplete results for the data items 

used in the calculation. The % risk therefore cannot be calculated for these patients. 

 

This data is displayed under the tab 

• Excluded and Incomplete 

 

Excluded patient details                    Incomplete patient details 

 

 
 

Incomplete data 

This horizontal bar chart helps practice staff improve their data quality by identifying 

patients with missing data. The Export button can be used for this purpose as described 

above. 
 

Excluded data 

The number of patients that have been excluded is provided in order of exclusion category: 

<20, >79, ATSI, diabetic, CVD. Once a patient is excluded for meeting an exclusion 

category they are not counted for subsequent categories. 
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7.2.14. HMR (Home Medicines Review) 

 

 

The HMR tab filters out patients who are not on any medications. The population figure on 

this tab is the number of patients who have current medications listed.  

 

The HMR tab displays the current medication status by the number of medications per 

patient. The number of medications is broken down 0, 1, 2, 3, 4, 5, 6, 7, 8+.  

 

 

 
 

The data is displayed as a pie chart. Functions available are as described for Allergies. 
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Exporting the data to a patient list for HMR will show you exactly how many medications a 

patient is on. 

 

 
 

 

Exporting this list to Excel will allow you to sort the data by medication count, allowing you 

to target patients on the greatest number of medications. 

 

 
 

7.2.14.1. HMR Mappings with Clinical systems 
 

Medications are flagged as true if they are on the patient’s current medication list. The 

collection process does not make any decisions about whether a medication should actually 

have been removed from the current medication list. The GP is responsible for making sure 

the list of medications is accurate. 

 

The HMR number of current medications is the total count of medications on the patient’s 

current medication list. 

 

Details of where the current medication list is found are provided in the ‘Medications Data 

Mappings’ Appendices for each Clinical application. 
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7.2.15. Immunisations 

 

The Immunisations tab contains sub-tabs for Influenza, Pneumococcal, Gardasil and 

Pertrussis. 

 

The charts are all pie charts. 

 

• Influenza, Pneumococcal and Pertussis all display the most recent date the patient 

had the immunisation or if no immunisation is recorded. 

 

• Gardasil displays the number of doses a patient has had or if no dose is recorded. 

The reidentification report includes the date of the last immunisation. 

 

 

Immunisation tab  

 

 
 

 

Immunisation charts 

 

    

Chart functions available are as described for Allergies. 

 

 

7.2.15.1. Immunisations Mappings with Clinical systems 
 

Medical Director 

Immunisations are collected if they have been entered in the MD Immunisations tab.  

The values collected for each type of immunisation are: 

 

Influenza 

 

Pneumococcal 

 

Gardasil 

 

Pertussis 

 

FLUVAX  

FLUARIX  

FLUAD  

FLUVIRIN  

INFLUENZA  

INFLUVAC  
VAXIGRIP  
VAXIGRIP JUNIOR 

 

PNEUMOVAX 23 

PNEUMOVAX 

GARDASIL 

 

ADACEL 

BOOSTRIX 

BOOSTRIX IPV 

DTP 

PERTUSSIS 

 

 

 

Best Practice and Genie   This function is not available yet.
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8. Reports 
 

8.1. Standard Reports 

 

A number of reports are available under the ‘Standard Reports’ tab. 

 

 
 

These are: 

 

• NPCC (National Primary Care Collaboratives) Report 
• NPI (National Performance Indicators) 

• Summary Report Card 
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8.1.1. NPCC (National Primary Care Collaboratives) Report  
 

The NPCC Report is available under the ‘Standard Reports’ tab. 

 

The NPCC Report is always derived from your full data set not your filtered data set. It will 

always show the practice total number of Diabetes and CHD patients. 

 

This report provides you with summary statistics for your patients who are listed on the 

Diabetes Register and Coronary Heart Disease Register. 

 

This report cannot be filtered by date. It is applicable only to the date at which 

the data collection was extracted. The date of extract will appear on the report.  

The reason is because CAT collects a ‘snap-shot’ of a patient’s current results at the date of 

extract. It does not collect a full patient history and hence it is not possible to create an 

NPCC report retrospectively.  

 

A report toolbar is available which provides functions to view, print and export the 

document. 
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8.1.2. NPI (National Performance Indicators) Report 
 

The NPI Reports are available under the ‘Standard Reports’ tab. 

 

The NPI Reports are always derived from your full data set not your filtered data set.  

 

The following NPI Reports for 2008-09 are available: 

• CDM 2 for reporting on Diabetes patients HbA1c results in last 12mths 

• CDM 3 for reporting on CHD patients with BP < 130/80 in last 12 mths 

• PREV 4 for reporting on female patients aged 20-69 with a pap smear in last 2 yrs 

 

This report cannot be filtered by date. It is applicable only to the date at which 

the data collection was extracted. The date of extract will appear on the report.  

The reason is because CAT collects a ‘snap-shot’ of a patient’s current results at the date of 

extract. It does not collect a full patient history and hence it is not possible to create an 

NPI reports retrospectively.  

 

A report toolbar is available which provides functions to view, print and export the 

document. 
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8.1.3. Summary Report Card 
 

The Summary Report Card is available under the ‘Standard Reports’ tab. 

 

This report provides an instant snapshot of GP data quality across most of the graphs 

provided. This means the user doesn't have to go to each tab and write the figures down.  

 

The report can be exported to Excel so the user can create a month by month set of figures 

if they choose. [Note the user needs to collect new extract files for each monthly report.]  

 

 

The user can also use the filters to target specific populations. 

 

 

This report is found under the ‘Standard Reports’ tab > ‘Summary Report Card’ tab 
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8.2. Cross Tabulation Report 

 

The cross tabulation report provides the ability to find patients who appear on more than one 

graph - this assists with the identification of target population risk groups.  

 

For example: Highlight the graphs segment for BMI >30, Smoker, BP >140/90, Cholesterol 

level >7.5 and view which patients meet all these criteria. 

 

As you highlight report chart segments you will see 2 pieces of information on the screen 

1. A ● will appear on the tab where you have made a chart segment selection 

2. A new line will appear underneath where the filter details display. This line will provide 

details of which chart segments are selected 

 

This example below shows BMI (Obese, Morbid), Smoking (Daily), BP (>140/90). Lipids – 

Cholesterol (>7.5) 

 

 
 

You will also see that the new ‘Report’ button has become active. 

 

Click the ‘Report’ button 

The standard Reidentify Report will display in an adjusted format to allow the data values for 

the chart selections you have made to be provided. 
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8.2.1. Clearing Report Selections  
 

 

To clear the Report Chart Segments you have selected click the ‘Clear Filters’ button at the 

top right hand corner of the CAT screen. The ‘Clear Filters’ dialogue box will appear. 

 

The ‘Clear all Report Selections’ tick box will be pre-selected if report segment selections 
have been made. Click ‘OK’. 

 

 

 
The ● which appears on the tabs with selected report segments will be cleared. The text line 

with selected report segments information will be cleared. 
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9. How to improve data quality using CAT 
 

There are a number of ways that CAT can be used to improve the data quality of your 

clinical desktop system. Some of these are listed below. 

 

9.1. Patients with no Date of Birth 

 

Patients with no date of birth (DOB) will have their age set to 999 in the data set. To find 

them use the age filter. 

 

• Set the Start Age = 998 

• Click the ‘Recalculate’ button 

• Click the ‘View Pop.’ Button 

• The Patient report for this filtered group will be displayed and you will see that the 

DOB column is empty 

 

 

 

9.2. Patients with no Gender 

 

Patients with no gender will have their gender as something other than ‘M’ or ‘F’ in the data 
set – probably it will be blank. To find them use the gender filter. 

 

• Tick Gender = Other 

• Click the ‘Recalculate’ button 

• Click the ‘View Pop.’ Button 

• The Patient report for this filtered group will be displayed and you will see that the 

sex column is empty or has something other than ‘M’ or ‘F’ 

 

 

 

9.3. Patients with no Allergy status recorded 

 

The Allergies tab displays your data as a breakdown of allergy status: Allergy Recorded, No 
Known Allergies, Nothing Recorded.  

 

Use this tab to identify patients with the status of ‘Nothing Recorded’. 

 

Refer to the section on Allergies. 

 

 

 

9.4. Patients with no Smoking status recorded 

 

Smoking displays your data as a breakdown of smoking status: Daily Smoker, Irregular 

Smoker, Ex Smoker, Never Smoked, Nothing Recorded.  

 
Use this tab to identify patients with the status of ‘Nothing Recorded’.  

 

You may need to use the age filter to exclude patients under 10 years old. 

 

Refer to the section on Smoking. 
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9.5. Patients with incorrect Diabetes coding 

 

Patients with Diabetes should be coded with a Diagnosis of Type I or Type II. 

 

To find incorrect coding search for 

 

i) Patients with both Type I and Type II recorded 

� Tick the Diabetes ‘Type I’ checkbox 

� Tick the Diabetes ‘Type II’ checkbox 

� Click the ‘Recalculate’ button 

� Click the ‘View Pop.’ Button 

� The Patient report for this filtered group will have both diagnosis 

recorded 

 

 

ii) Patients with an Undefined only diagnosis recorded – patients should have 

a primary diagnosis of Type I or Type II recorded 

� Tick the Diabetes ‘Type I’  NO checkbox 

� Tick the Diabetes ‘Type II’ NO checkbox 

� Tick the Diabetes ‘Undefined’ checkbox 

� Click the ‘Recalculate’ button 

� Click the ‘View Pop.’ Button 

� The Patient report for this filtered group will no primary Diabetes 

diagnosis recorded 
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iii)  

10. FURTHER INFORMATION 
 

For further information about the Clinical Audit Tool contact PEN Computer Systems. 

 

Head Office: 

 

Pen Computer Systems Pty Ltd 

Level 6, 10-14 Smith St 

PARRAMATTA NSW 2150 

 
Phone:  61 2 9635 8955 

Fax:  61 2 9635 8966 

Email:  enquiries@pencs.com.au 

Web:  www.pencs.com.au 

 

Melbourne Office: 

 

Pen Computer Systems Pty Ltd 

Level 5, 434 St Kilda Road 

MELBOURNE VIC 3004 

 

Phone:  61 3 9866 8477 

Fax:  61 3 9866 5699 
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11. APPENDIX A - GENIE DATA COLLECTION 
 

For Genie users the data set collection is performed from within the Genie software 

application. Clicking the CAT ‘Collect’ button at the top left of the screen will provide you with 

the summary steps on how this is done within Genie. 

 

 
 

 

 

 
Collecting data sets from within Genie 

 

Open the Genie application 

 

Click on the ‘File’ menu option and choose ‘Maintenance & Reports’ 
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From the ‘Maintenance & Reports’ window click the ‘Clinical Audit Export’ button 

 

 
 

 

From the ‘Clinical Audit’ dialogue box click the ‘Browse’ button to select the folder you wish 

to export your data extract to.  
This should be set to match your Clinical Audit ‘Data Folder Location’ preference. 
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Click the ‘Export’ button to start the data extract 

 

 
 

Two files will be created – the link file and then the data file – you will be shown the 

progress of each file extract 

 

Once the export has completed you will see the ‘Export Complete’ message displayed. 
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12. APPENDIX B – MEDICAL DIRECTOR DATA CATEGORY MAPPINGS 
 

12.1. APPENDIX B-1 – CONDITIONS DATA CATEGORY MAPPINGS (MD) 

 
The data collection process collects conditions that are found on the MD ‘Past History’ 

screen. Chronic conditions are flagged as true for a patient if the condition is marked as 

either active or inactive. 

 

From the list below only Asthma and Depression are regarded as being recoverable. These 

conditions are flagged as true if they are marked as active only. 

 
 

CAT Category Medical Director Mapping 

Diabetes   

Type II  

 Diabetes Mellitus - NIDDM 

Diabetes Mellitus - Type II 

NIDDM 

Non insulin dependent diabetes mellitus 

Type I  

 Diabetes Mellitus - IDDM 

Diabetes Mellitus - Type I 

IDDM (Insulin dependent diabetes mellitus) 

Insulin dependent diabetes mellitus 

Juvenile Onset Diabetes 

Undefined diabetic  

   Arteritis - Diabetes Mellitus 

Diabetes 

Diabetes - controlled 

Diabetes - Unstable 

Diabetes Mellitus 

Diabetes with Vascular Changes 

Diabetic Endarteritis 

Diabetic Peripheral Vascular Disease 

Diabetic Vascular Disease - Peripheral 

Unstable Diabetes 

Respiratory  

Asthma  
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     [Active only conditions  

      are collected] 

Acute severe asthma 

Allergy induced asthma 

Asthma 

Asthma - Allergy induced 

Asthma - Chronic Persistent 

Asthma - Exercise induced 

Asthma - Frequent Episodic 

Asthma - Infective exacerbation 

Asthma – Infrequent Episodic 

Bronchial asthma 

Exercise induced asthma 

Exertional asthma 

Status asthmaticus 

Wheezy bronchitis 

 

 

 

COPD  

   Chronic Airways Limitation 

Chronic Bronchitis 

Chronic Obstructive Airways Disease 

Chronic Obstructive Pulmonary Disease 

COAD 

COAD (Chronic Obstructive Airways Disease) 

COPD (Chronic Obstructive Pulmonary Disease) 

Cardiovascular  

CHD  

   Acute coronary insufficiency 

Acute myocardial infarction 

AMI (Acute Myocardial Infarction) 

Angina 

Angina pectoris 

Angina pectoris - Prinzmetal 
Angina pectoris - unstable 

Angioplasty - coronary 

Angioplasty - coronary (with stent) 

Anterior myocardial infarct 

Anterolateral myocardial infarct 

Atherosclerotic heart disease 

Balloon coronary angioplasty 

Blockage Coronary Artery 

Bypass - coronary 

CABG (Coronary Artery Bypass Graft) 

Coronary Angiography and Stent 

Coronary artery balloon angioplasty 

Coronary artery bypass graft 

Coronary artery disease 

Coronary artery disease - Rehabilitation 

Coronary artery endarterectomy 

Coronary artery spasm 

Coronary artery stent 

Coronary artery surgery 

Coronary heart disease 

Coronary insufficiency 
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Coronary Occlusion 

Heart attack 

IHD (Ischaemic Heart Disease) 

Inferior myocardial infarction 

Ischaemic heart disease 

Myocardial Damage 

Myocardial infarction 

Myocardial infarction - anterolateral 

Myocardial infarction - inferior 

Myocardial infarction - posterior 

Myocardial infarction - subendocardial 

Myocardial infarction - superior 

Myocardial Infarction - with ST elevation 

Myocardial Infarction - without ST elevation 

Myocardial insufficiency 

NSTEMI (Non-ST-Elevation Myocardial Infarction) 

Occlusion - Coronary Artery 

PCTA 

Percutaneous transluminal angioplasty 

Posterior myocardial infarct 

Preinfarction syndrome 

Prinzmetal angina 

STEMI (ST-Elevation Myocardial Infarction) 

Stent - coronary artery 

Subendocardial myocardial infarct 

Superior myocardial infarct 

Surgery - Coronary artery 

Surgery - Coronary artery balloon angioplasty 

Surgery - Coronary artery bypass graft 

Surgery - Coronary artery endarterectomy 

Surgery - Coronary artery stent 

Unstable Angina 

Unstable Angina - High risk 

Unstable Angina - Low risk 

Unstable Angina - Moderate risk 

Variant angina 

Hypertension  

   Antihypertensive agent prescription 

Blood Pressure Labile 

Blood Pressure review 

BP Labile 

BP Unstable 

Essential hypertension 
HBP 

High blood pressure 

HT (Hypertension) 

Hypertension 

Hypertension - Borderline 

Hypertension - Controlled 

Hypertension - Isolated Systolic 

Hypertension - Labile 

Hypertension - Life style management 

Hypertension - Malignant 

Hypertension - Portal 
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Hypertension - Renovascular 

Hypertension - Unstable 

Hypertension review 

Hypertensive crisis 

Labile Blood Pressure 

Labile BP 

Labile Hypertension 

Malignant hypertension 

Portal hypertension 

Prescription - Hypertension 

Primary hypertension 

Renal Hypertension 

Renovascular Hypertension 

Review - BP 

Severe refractory hypertension 

 

 

 

 

Heart Failure  

   Acute cardiac failure 

Acute heart failure 

Cardiac failure 

CCF 

Congestive Cardiac Failure 

Congestive Heart Failure 

Cor pulmonale 

Heart failure 

Heart failure - Acute 

Heart failure - Biventricular 

Heart failure - High output 

Heart failure - Left 

Heart failure - Right 

High output cardiac failure 

High output heart failure 

Hypertensive heart failure 

Left ventricular failure 

LHF (Left heart failure) 

LVF (Left ventricular failure) 

Pulmonary oedema 

RHF (Right heart failure) 

Right ventricular failure 

RVF (Right ventricular failure) 

Stroke  
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   Cerebral Haemorrhage 

Cerebrovascular Accident 

CVA (Cerebrovascular Accident) 

Haemorrhage - intracerebral 

Haemorrhagic CVA 

Haemorrhagic Stroke 

Intracerebral bleed 

Intracerebral haemorrhage 

Ischaemic Stroke 

Lacunar Stroke 

Migranous Stroke 

Stroke 

Stroke - Haemorrhagic 

Stroke - Ischaemic 

Stroke - Lacunar 

Stroke - Migranous 

Stroke - Thrombotic 

Thrombotic - Stroke 
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Mental Health  

Depression  

  

 

     [Active only conditions  

      are collected] 

Anxiety/Depression 

Depression - Endogenous 

Depression - Major 

Depression - Minor 

Depression - Post Natal 

Depression - Reactive 

Depression - recurrent 

Depressive anxiety disorder 

Endogenous depression 

Melancholia 

Mixed anxiety/depressive disorder 

Organic depression 

Post Natal Depression 

Reactive depression 

Anxiety  

   Anxiety 

Anxiety - Generalised 

Anxiety - Social 

Anxiety disorder 

Anxiety feeling 

Anxiety neurosis 

Anxiety phobia 

Anxiety/Depression 
Depressive anxiety disorder 

Feeling anxious 

GAD (Generalised Anxiety Disorder) 

Generalised Anxiety Disorder (GAD) 

Mixed anxiety/depressive disorder 

Mood - anxious 

Nervous 

Nervous Anxiety 

Neurotic anxiety 

Phobia 

Social Anxiety Disorder 

Social Phobia 

Tense 

Schizophrenia  

  Borderline schizophrenia 

Brief reactive schizophrenia 

Catatonic schizophrenia 

Chronic Schizophrenia 

Paranoid schizophrenia 
Schizophrenia 

Schizophrenia - borderline 

Schizophrenia - brief 

Schizophrenia - catatonic 

Schizophrenia - chronic 

Schizophrenia - paranoid 
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Bone Disease  

Osteoporosis  

   Osteopaenia 

Osteopenia 

Osteoporosis 

Osteoporosis - corticosteroid induced 

Osteoporosis - no fracture 

Osteoporosis with fracture 

Post menopausal osteoporosis 

Steroid induced osteoporosis 

Steroid osteopathy 

Osteoarthritis  

  Arthritis - Osteo 

Hip Osteoarthritis 

Hip Osteoarthrosis 

Knee Osteoarthritis 

Knee Osteoarthrosis 

OA (Osteoarthritis) 

Osteoarthritis 

Osteoarthritis - Ankle 

Osteoarthritis - Fingers 

Osteoarthritis - Hands 

Osteoarthritis - Hip 

Osteoarthritis - Knee 

Osteoarthritis - Neck 
Osteoarthritis - Shoulder 

Osteoarthritis - Spine 

Osteoarthrosis 

Spondylosis 

Wear and tear arthritis 

Other  

Hyperlipidaemia  

   Dyslipidaemia 

High cholesterol 

Hypercholesterolaemia 

Hyperlipidaemia 

Hyperlipidaemia - controlled 

Hyperlipidaemia review 

Hyperlipidaemia type 2 

Hyperlipoproteinaemia - Type2 

Review – hyperlipidaemia 
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Renal Impairment  

   Acute renal failure 

Chronic Renal Failure 

Cirrhosis with acute renal failure 

Dialysis - haemodialysis 

Haemodialysis 

Hemodialysis 
Hepatorenal syndrome 

Impairment - Renal 

Kidney failure 

Kidney failure - acute 

Kidney failure - chronic 

Kidney Impairment 

Renal artery stenosis 

Renal Damage 

Renal dialysis 

Renal failure 

Renal failure due to cirrhosis 

Renal Impairment 

Renal insufficiency - acute 

Renal insufficiency - chronic 

Stenosis - Renal artery 

Uraemia 

Kidney Disease – Chronic – Stage 1 -5 

Renal Disease – Chronic – Stage 1 -5 

Chronic Kidney Disease - Stage 1 -5 

CKD (Chronic Kidney Disease) – Stage 1 -5 

 

 
 

12.1.1. Pregnancy 

 
Pregnancy is true if the patient has an incomplete pregnancy under the Obstetrics tab.
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12.2. APPENDIX B-2 – MEDICATIONS DATA CATEGORY MAPPINGS (MD) 
 

The data collection process collects medications that are found on the MD ‘RX’ screen. It does 

not make any decisions about whether a medication should actually have been removed from 

the ‘RX’ screen. The GP is responsible for making sure the list of medications is accurate. 

 

Medications - Heart 

 

CAT Category 

 

Medical Director Mapping 

ARB Class: 

 

Cardiovascular System > Antihypertensives > 

Angiotension II Antagonists > All  

 

ACE Inhibitors Class: 
 

Cardiovascular System > Antihypertensives > ACE 

Inhibitors > All 

 

Aspirin Generic Names: 

 

Aspirin  

Aspirin/Dipyridamole 

Aspirin/Citric Acid/Sodium Bicarbonate 

Aspirin/Citric Acid/Sodium Bicarbonate/Sodium 

Aspirin/Glycine  

 

Warfarin 

 

Generic Names: 

 

Warfarin 

 

Clopidogrel 

 

Generic Names: 

 

Clopidogrel 

 

Beta Blockers - 

Antihypertensive 

 

Generic Names: 

 

Atenolol 

Bisoprolol  

Carvedilol  

Labetalol 
Metoprolol 

Oxprenolol 

Pindolol  

Propranolol  
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Beta Blockers – 

Chronic heart failure 

Generic Names: 

 

Bisoprolol 

Carvedilol 

 

Brand Names: 

[these are controlled release preparations of 

Metoprolol and Metoprolol Succinate] 

 

Toprol-XL 

Toprol-XL Titration Pack 

 

Beta Blockers - 

Myocardial Infarction 

Generic Names: 

 

Atenolol 

Betaxolol Hydrochloride 

Bisoprolol Fumarate 

Carvedilol 

Esmolol Hydrochloride 

Labetalol Hydrochloride  

Metoprolol Succinate 

Oxprenolol Hydrochloride 

Pindolol 

Sotalol  

Sotalol Hydrochloride         

 

Calcium Antagonists Class: 

 

Cardiovascular System > Antihypertensives > 

Calcium Channel Blockers > All 

 

Diuretics Classes: 

 

Cardiovascular System > Antihypertensives > 

Diuretic 

 

Cardiovascular System > Antihypertensives > 

Diuretic > Diuretic Herbal 

 

Cardiovascular System > Antihypertensives > 

Diuretic > Diuretic Potassium Sparing 

 

Lipid M/fying - Statins Generic Names: 

  

Atorvastatin  

Atorvastatin/Amlodipine 

Fluvastatin  

Pravastatin 

Simvastatin 

Ezetimibe/Simvastatin 
Rosuvastatin 
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Lipid M/fying - Other Generic Names: 

 

Cholestyramine 

Clofibrate 

Colestipol 

Ezetimibe 

Fenofibrate 

Gemfibrozil 

Cerivastatin 

Probucol 

Nicotinic Acid 

Avena Sativa/Nicotinic Acid 

Policosanol 

 

 
Medications Other 

 

Antidiabetics 

H/glycaemics – Insulin Class: 

 

Hormones And Metabolic Products > Antidiabetic 

Agents > Hypoglycaemic Agents – Insulin > All 

 

H/glycaemics – Oral Class: 

 

Hormones And Metabolic Products > Antidiabetic 

Agents > Hypoglycaemic Agents – Oral > All 

 

Metformin Generic Names: 

 

Metformin  

Rosiglitazone/metformin 

Metformin hydrochloride/glibenclamide 
 

Mental Health 

Antipsychotics 

 

Class: 

 

Nervous System > Antipsychotics 

 

Corticosterids 

Glucocorticoids Class: 

 

Hormones and Metabolic Products > Adrenal 

Hormones > Corticosteroid  > Corticosteroid-

Glucocorticoid 
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Pain Relief 

NSAIDs Generic Names: 

 

Diclofenac 

Diclofenac/Misoprostol                                                   

Ibuprofen                                                                       

Ibuprofen Lysine                                                                

Ibuprofen/Codeine                                                               

Ibuprofen/Codeine Phosphate                                                     

Ibuprofen/Pseudoephedrine Hydrochloride                                         

Indomethacin   

Ketorolac 

Ketoprofen                                                                      

Ketorolac Trometamol                                                            

Mefenamic Acid                                                                  

Naproxen                                                                        

Piroxicam                                                                       

Sulindac                                                                        

Tiaprofenic Acid 

 

Class: 
 

Musculoskeletal Agents > Antiinflammatory Agents> 

Systemic NSAIDs > COX 2 Inhibitors 

 

COX2 Class: 

 

Musculoskeletal Agents > Antiinflammatory Agents> 

Systemic NSAIDs > COX 2 Inhibitors 

 

Respiratory 

Asthma – Inhaled Class: 

 

Respiratory > Antiasthmatic and/or COPD 

preparations > Antiasthmatic Preventative > Steroid – 

Inhaled 

 

Generic Names: 
 

Budesonide 

 

COPD Generic Names: 

 

Tiotropium 
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12.3. APPENDIX B-3 – GENERAL DATA CATEGORY MAPPINGS (MD) 

 
Demographic Medical Director Mapping 

 

Gender Patient Details screen > Sex 

Ethnicity Patient Details screen >  

Tick boxes for Aboriginal / TSI 

DVA Patient Details Screen > 

• the Pension Status set to ‘Full 

DVA’ or ‘Limited DVA’  

• or the DVA No. field has a 

value 

Age Patient Details screen > DOB 

Last Visit Past History screen > Checks dates on 

history progress notes items  

Postcode Patient Details screen > Postcode 

 
Allergy Medical Director Mapping 

 

Patient Details > Allergies tab 

Allergy Recorded An Allergy Item is present  

 

No Known 

Allergies 

The ‘No Known Allergies’ check box is 

checked  

 

Nothing Recorded No Allergy Items are present and the 

‘No Known Allergies’ check box is 

unchecked 

 

 
Smoking Medical Director Mapping 

 

Patient Details > Smoking tab > 

 

[Note that smoking data from the 

Diabetes record is not used. Adding 

data to the diabetes record does not 

update the smoking tab which is taken 
as the primary MD smoking data.] 

 

Daily Smoker Smoker = Smoker is selected and 

frequency is daily 

 

Irregular Smoker Smoker = Smoker is selected and 

frequency is not daily 

 

Ex Smoker Smoker = Ex-Smoker is selected 

 

Never Smoked Smoker = Never smoked is selected 

 

Nothing Recorded Smoker has nothing selected 
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Measurements Medical Director Mapping 

 

BMI Clinical > Diabetes Record > Add Values 

OR 

Tools > Weight Calculator 

 

Cholesterol Clinical > Diabetes Record > Add Values 

OR 

Pathology HL7 results 

 

HDL Clinical > Diabetes Record > Add Values 

OR 

Pathology HL7 results 

 

LDL Clinical > Diabetes Record > Assessment 

OR 

Pathology HL7 results 

 

Triglycerides Clinical > Diabetes Record > Add Values 

OR 

Pathology HL7 results 

 

Creatinine Clinical > Measurements > Add Values 

OR 

Pathology HL7 results 

 

Microalbinuria Clinical > Measurements > Assessment 

OR 

Pathology HL7 results 

 

HbA1c Clinical > Diabetes Record > Add Values 

OR 

Pathology HL7 results 

 

BP Clinical > Diabetes Record > Add Values 

OR  

Tools > BP Monitor > Sitting 

 

 
 

Diseases Medical Director Mapping 

Condition Past History screen > Checks the 

condition selected on history items, where 

Conditions are selected from a coded list.  

 

Refer to the Appendices for a list of 

conditions mapping to each CAT condition. 
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Pap Smear Medical Director Mapping 

 

1. Female Patient Record >   
     Smears tab 

 

Recorded An entry is present on the tab 

Done Date Date of most recent entry 

  

2. Pathology HL7 Results 
 

Recorded True if a result exists 

Done Date Date of test result 

 

 
Medications Medical Director Mapping 

Medication Current Rx screen >  

Checks the Drugs listed, where Drugs are 

selected from a coded list  

 

Refer to the Appendices for a list of 

medications mapping to each CAT 

medication. 

 

HMR Current Rx screen > Counts All Drugs 

listed as current medications 
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12.4. APPENDIX B-4 – DIABETES SIP DATA CATEGORY MAPPINGS (MD) 
 

Diabetes SIP 

Item 

Medical Director Mapping 

HbA1c Clinical > Diabetes Record > Add Values 

OR 

Pathology HL7 results 
 

Eye Exam Clinical > Diabetes Record > Add Values 

 

BMI Clinical > Diabetes Record > Add Values 

OR 

Tools > Weight Calculator 

 

BP Clinical > Diabetes Record > Add Values 

OR  

Tools > BP Monitor > Sitting 

 

Foot Exam Clinical > Diabetes Record > Add Values 

or Assessment : 
Foot Exam or Podiatrist Attendance date 

entered 

 

Cholesterol Clinical > Diabetes Record > Add Values 

OR 

Pathology HL7 results 

 

Triglycerides Clinical > Diabetes Record > Add Values 

OR 

Pathology HL7 results 

 

HDL Clinical > Diabetes Record > Add Values 

OR 

Pathology HL7 results 

 

Microalbuminuria Clinical > Diabetes Record > Assessment 

OR 

Pathology HL7 results 

 

Smoking Patient Details > Smoking tab 

 

[Note that smoking data from the 

Diabetes record is not used. Adding data 

to the diabetes record does not update 

the smoking tab which is taken as the 

primary MD smoking data.] 
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13. APPENDIX C – BEST PRACTICE DATA MAPPINGS 
 

13.1. APPENDIX C-1 - CONDITIONS DATA MAPPINGS (BP) 
 

Best Practice only collects active conditions. This is the default setting. A clinician must 

make a choice when making a condition inactive and hence inactive conditions are not 

collected. 

 

(In contrast Medical Director defaults a condition to inactive.)  

 

CAT Category Best Practice Mapping 

Diabetes   

  > Type II Diabetes Mellitus, NIDDM 

Diabetes Mellitus, Type 2 
NIDDM 

Non insulin dependent Diabetes Mellitus 

Type 2 Diabetes Mellitus 

  > Type I Diabetes mellitus, IDDM 

Diabetes mellitus, Type 1 

IDDM 

Insulin dependent Diabetes mellitus 

Juvenile onset Diabetes mellitus 

Type 1 Diabetes mellitus 

  > Undefined diabetic Diabetes 

Diabetes - controlled 

Diabetes - Unstable 

Diabetes Mellitus 

Diabetic endarteritis 

Diabetic peripheral vascular disease 

Peripheral vascular disease, diabetic 

Unstable Diabetes 

Respiratory  

  > Asthma Acute severe asthma 

Allergic asthma 

Allergy induced asthma 

Asthma 

Asthma review 

Asthma, allergy induced 

Asthma, exercise induced 

Asthma, infective exacerbation 
Bronchial asthma 

Exercise induced asthma 

Exertional asthma 

Infective exacerbation of asthma 

Status asthmaticus 

Wheezy bronchitis 
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  > COPD Bronchitis, chronic 

Chronic bronchitis 

Chronic Obstructive Airways Disease 

Chronic Obstructive Pulmonary Disease 

COAD 

COAD - Infective exacerbation 

COPD 

Emphysema 

Cardiovascular  

  > CHD Acute coronary insufficiency 

Acute myocardial infarction 

AMI 

Angina 

Angina pectoris 

Angiogram, coronary 

Angioplasty, coronary 

Anterior myocardial infarct 
Anterolateral myocardial infarct 

Balloon coronary angioplasty 

CABG 

Coronary angiogram 

Coronary angiography 

Coronary Angiography - No significant obstr 

Coronary angioplasty 

Coronary angioplasty with stent 

Coronary artery bypass graft 

Coronary artery disease 

Coronary artery endarterectomy 

Coronary artery stent 

Coronary endarterectomy 

Coronary insufficiency 

Coronary occlusion 

Health assessment 

Heart attack 

IHD 

Inferior myocardial infarction 

Ischaemic heart disease 

MI 

Myocardial infarction 

Myocardial infarction, anterior 

Myocardial infarction, anterolateral 

Myocardial infarction, inferior 

Myocardial infarction, posterior 
Myocardial infarction, subendocardial 

Myocardial infarction, superior 

Occlusion, Coronary artery 

Posterior myocardial infarct 

Preinfarction syndrome 

Stent, coronary artery 

Subendocardial infarct 

Subendocardial myocardial infarct 

Superior myocardial infarct 

Unstable angina 
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  > Hypertension Borderline hypertension 

Essential hypertension 

High blood pressure 

Hypertension 

Hypertension - Preventive care 

Hypertension in pregnancy 

Hypertension,  Isolated systolic 

Hypertension, borderline 

Hypertension, malignant 

Hypertension, portal 

Hypertension, pulmonary 

Hypertension, renovascular 
Hypertension, white coat 

Idiopathic pulmonary hypertension 

Isolated systolic hypertension 

Labile Blood Pressure 

Labile BP 

Malignant hypertension 

Portal hypertension 

Pregnancy induced hypertension 

Preventive care - Hypertension 

Primary pulmonary hypertension 

Pulmonary hypertension 

Renal hypertension 

Renovascular hypertension 

Severe refractory hypertension 

White coat hypertension 

  > Heart Failure Acute cardiac failure 

Acute heart failure 

Biventricular heart failure 

Cardiac failure 

Cardiac failure, acute 

CCF 

Congestive cardiac failure 

Congestive heart failure 

Cor pulmonale 

Heart failure 

Heart failure, acute 

Heart failure, high output 

Heart failure, left 

High output cardiac failure 

High output heart failure 

Hypertensive heart failure 

Left heart failure 

Left Ventricular Failure 

LHF 

LVF 

RHF 
Right heart failure 

Right ventricular failure 

RVF 
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  > Stroke Cerebral haemorrhage 

Cerebral infarction 

Cerebrovascular Accident 

CVA 

Haemorrhage, intracerebral 

Haemorrhagic CVA 

Haemorrhagic stroke 

Intracerebral bleed 

Intracerebral haemorrhage 

Intracranial haemorrhage 

Ischaemic stroke 

Lacunar Stroke 

Migrainous stroke 

Stroke 

Stroke, haemorrhagic 

Stroke, ischaemic 

Stroke, lacunar 

Stroke, migrainous 

Stroke, thrombotic 

Thrombotic stroke 

Mental Health  

  > Depression Anxiety/Depression 

Depression 

Depression, endogenous 

Depression, Post Natal 

Depression, reactive 

Endogenous depression 

Neurotic depression 

Organic depression 

Post Natal Depression 

Reactive depression 

  > Anxiety Anxiety 

Anxiety disorder 

Anxiety neurosis 

Anxiety/Depression 

Fear, irrational 

GAD 

Generalised Anxiety Disorder 

Irrational fear 

Neurotic depression 

Phobia 

Phobic anxiety disorder 

Phobic disorder 

Social Anxiety Disorder 

Social phobia 

  > Schizophrenia Borderline schizophrenia 

Catatonic schizophrenia 

Chronic schizophrenia 

Paranoid schizophrenia 

Schizophrenia 
Schizophrenia, borderline 

Schizophrenia, catatonic 

Schizophrenia, chronic 

Schizophrenia, paranoid 
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Bone Disease  

  > Osteoporosis Osteopenia 

Osteoporosis 

Osteoporosis, steroid induced 

Steroid induced osteoporosis 

Steroid osteopathy 

  > Osteoarthritis Ankle osteoarthritis 

Cervical spine osteoarthritis 

Hip osteoarthritis 

Hip osteoarthrosis 

Knee osteoarthritis 

Knee osteoarthrosis 

Lumbar spine osteoarthritis 

OA 

Osteoarthritis 

Osteoarthritis  in neck 

Osteoarthritis cervical spine 

Osteoarthritis in fingers 
Osteoarthritis in hand 

Osteoarthritis in lumbar spine 

Osteoarthritis of ankle 

Osteoarthritis of hip 

Osteoarthritis of knee 

Osteoarthrosis 

Other  

  > Hyperlipidaemia Dyslipidaemia 

Familial hypercholesterolaemia 

Hyperlipidaemia 

Hyperlipidaemia type 2 

Hyperlipoproteinaemia,  Type 2 

 

 
13.1.1. Pregnancy 

 
Pregnancy is true if the patient has a current pregnancy under the Obstetrics tab.
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13.2. APPENDIX C-2 - MEDICATIONS DATA MAPPINGS (BP) 

 
CAT Category Best Practice Mapping – Generic Name 

ARB Candesartan Cilexetil 

Candesartan Cilexetil, Hydrochlorothiazide 

Eprosartan Mesylate 

Eprosartan Mesylate, Hydrochlorothiazide 

Irbesartan 

Irbesartan, Hydrochlorothiazide 

Losartan Potassium 

Olmesartan medoxomil 

Olmesartan medoxomil, Hydrochlorothiazide 

Telmisartan 

Telmisartan, Hydrochlorothiazide 

 

ACE Inhibitors Captopril 

Enalapril Maleate 

Enalapril Maleate, Hydrochlorothiazide 

Fosinopril Sodium 

Fosinopril Sodium, Hydrochlorothiazide 

Lisinopril 

Perindopril Arginine 

Perindopril arginine, Indapamide hemihydrate 

Perindopril Erbumine 

Perindopril erbumine, Indapamide hemihydrate 

Quinapril 
Quinapril, Hydrochlorothiazide 

Ramipril 

Ramipril, Felodipine 

Trandolapril 

Trandolapril, Verapamil 

 

Aspirin Aspirin 

Aspirin, Glycine 

Dipyridamole, Aspirin 

 

Beta Blockers Atenolol 

Bisoprolol fumarate 

Carvedilol 

Labetalol Hydrochloride 

Metoprolol Succinate 

Metoprolol Tartrate 

Oxprenolol Hydrochloride 

Pindolol 

Propranolol Hydrochloride 

Sotalol Hydrochloride 
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Calcium Antagonists Amlodipine 

Amlodipine Besylate 

Amlodipine besylate, atorvastatin 

Amlodipine Maleate 

Diltiazem Hydrochloride 

Diltiazem Hydrochloride (Controlled Delivery) 

Felodipine 

Lercanidipine Hydrochloride 

Nifedipine 

Ramipril, Felodipine 

Trandolapril, Verapamil 

Verapamil Hydrochloride 

 

Diuretics Bendrofluazide 

Bumetanide 

Candesartan Cilexetil 

Candesartan Cilexetil, Hydrochlorothiazide 

Diazoxide 

Enalapril Maleate, Hydrochlorothiazide 

Eprosartan Mesylate 

Eprosartan Mesylate, Hydrochlorothiazide 

Ethacrynic Acid 

Fosinopril Sodium, Hydrochlorothiazide 

Frusemide 

Hydrochlorothiazide 

Hydrochlorothiazide, Amiloride 

Hydrochlorothiazide, Triamterene 

Hydrochlorothiazide/Amiloride 

Hydrochlorothiazide/Triamterene 

Indapamide Hemihydrate 

Irbesartan, Hydrochlorothiazide 

Olmesartan medoxomil, Hydrochlorothiazide 

Perindopril arginine, Indapamide hemihydrate 
Quinapril, Hydrochlorothiazide 

Telmisartan, Hydrochlorothiazide 
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H/glycaemics – Insulin Insulin Aspart 

Insulin aspart 

Insulin aspart rys 

Insulin Aspart, Insulin Aspart Protamine 

Suspension 

Insulin detemir 

Insulin glargine 

Insulin glulisine 

Insulin Isophane (N.P.H.) Bovine 

Insulin Isophane (N.P.H.) Human 

Insulin lispro 

Insulin Lispro 

Insulin lispro, Insulin lispro Protamine Suspension 

Insulin Lispro, Insulin Lispro Protamine Suspension 

Insulin Neutral (Bovine) 

Insulin Neutral (Human) 

Insulin Neutral 20%, Isophane 80% Human 

Insulin Neutral 30%, Isophane 70% Human 

Insulin Neutral 30%, Isophane 70% Human 

Insulin Neutral Bovine 

Insulin Neutral, Isophane (Human) 

Insulin Neutral/Isophane (Human) 

Insulin Zinc Suspension (Human) 

Neutral Insulin (Human) 

 

H/glycaemics – Oral Glibenclamide 

Gliclazide 

Glimepiride 

Glipizide 

Metformin Hydrochloride 

Metformin Hydrochloride, Glibenclamide 

Metformin Hydrochloride, Glibenclamide 

Metformin, Glibenclamide 
Metformin, Glibenclamide 

Pioglitazone Hydrochloride 

Rosiglitazone 

Rosiglitazone Maleate, Metformin Hydrochloride 

Rosiglitazone Maleate, Metformin Hydrochloride 

 

Lipid M/fying - Statins Amlodipine besylate, atorvastatin 

Atorvastatin 

Ezetimibe, Simvastatin 

Fluvastatin 
Pravastatin Sodium 

Rosuvastatin 

Simvastatin 

Lipid M/fying  - Other Cholestyramine 

Colestipol Hydrochloride 

Ezetimibe 

Ezetimibe, Simvastatin 

Fenofibrate 

Gemfibrozil 

Nicotinic Acid 
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13.3. APPENDIX C-3 - GENERAL DATA MAPPINGS (BP) 
 

Demographic Best Practice Mapping 

Gender Open > Demographics screen > 

Sex 

Ethnicity Open > Demographics screen >  

Drop down list for Aboriginal / TSI 

DVA Open > Demographics screen > 

DVA No. has a value 

Age Open > Demographics screen > 

DOB 

Last Visit Past Visits screen > Checks most 

recent date in the list  

Postcode Open > Demographics screen > 

Postcode 

 

 

Allergy Best Practice Mapping 

 

Main Patient Screen > Allergies 

/ Adverse Drug Reactions Box 

Allergy Recorded An Allergy Item is present  

 

No Known Allergies The ‘Nil Known’ check box is 

checked  

 

Nothing Recorded No Allergy Items are present and 

the ‘Nil Known’ check box is 

unchecked 

 

 

 

Smoking Best Practice Mapping 

 

Main Patient screen > Open > 

Alcohol and Smoking History > 

Tobacco 

 

Daily Smoker Smoker = Smoker is selected  

 

Irregular Smoker This option is not captured in Best 

Practice 

 

Ex Smoker Smoker = Ex-Smoker is selected 

 

Never Smoked Smoker = Never smoked is selected 

 

Nothing Recorded Smoker has nothing selected 
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Measurements Best Practice Mapping 

 

BMI Patient Record >  Main Patient Screen > 

Observations screen  

 

Cholesterol 

HDL 

LDL 

Triglycerides 

Lipids data : 

Patient Record > Main Patient screen > 

Enhanced Primary Care > Diabetes Cycle 

of Care screen.  

 

Creatinine Patient Record > Main Patient screen > 

Enhanced Primary Care > Diabetes Cycle 

of Care screen.  
 

Microalbinuria Patient Record > Main Patient screen > 

Enhanced Primary Care > Diabetes Cycle 

of Care screen.  

 

HbA1c Patient Record > Main Patient screen > 
Enhanced Primary Care > Diabetes Cycle 

of Care screen.  

 

BP Patient Record > Main Patient screen 

either 

- opening the Observations screen, or 

- opening the Enhanced Primary Care > 

Diabetes Cycle of Care screen.  

 

 

 

 

 

 

Pap Smear 

The Pap Smear data can be found in Best Practice by opening a Female Patient Record 

and from the Main Patient screen opening the Cervical Smears screen. If there are 

smear tests they will be listed by date. 

 

Patients with tick-box ‘Not Required’ checked are ignored. 
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Disease Best Practice Mapping 

Condition Past History screen > Checks the 

condition selected on history items, 

where Conditions are selected from 

a coded list.  
 

Refer to Appendix C-1 for a list of 

conditions mapping to each CAT 

condition. 

 

 

Medications Best Practice Mapping 

Medication Current Rx screen > Checks the 

Drugs listed as current 

medications, where Drugs are 

selected from a coded list.  

 

Refer to Appendix C-2 for a list of 

medications mapping to each CAT 

medication. 

 
 

HMR Current Rx screen > Counts All 

Drugs listed as current medications 
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13.4. APPENDIX C-4 – DIABETES SIP DATA MAPPINGS (BP) 
 

 

Item Best Practice Mapping 

HbA1c Enhanced Primary Care > 

Diabetes Cycle of Care 
 

Eye Exam Enhanced Primary Care > 

Diabetes Cycle of Care 

 

BMI Observations 

 

BP Observations 

Or 

Enhanced Primary Care > 

Diabetes Cycle of Care 

 

Foot Exam Enhanced Primary Care > 

Diabetes Cycle of Care 
 

Cholesterol Enhanced Primary Care > 

Diabetes Cycle of Care 

 

Triglycerides Enhanced Primary Care > 

Diabetes Cycle of Care 

 

HDL Enhanced Primary Care > 

Diabetes Cycle of Care 

 

Microalbuminuria Enhanced Primary Care > 

Diabetes Cycle of Care 

 

Smoking Open > Alcohol and Smoking 

History > Tobacco 
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14. APPENDIX D – GENIE DATA MAPPINGS 
 

14.1. APPENDIX D-1 - CONDITIONS DATA MAPPINGS (GENIE) 
 

An * next to the CAT category indicates that Genie checks current problems and past history 

 

Note: Where ICPC Codes are not being used, Genie checks the problem text and some 

patient medications to determine if a condition exists – these are noted against the category. 

 
CAT Category Genie Condition Mapping (either of the following columns) 

 

 ICPC Code Problem Text 

Diabetes    

 Requires Diabetic box to be ticked and one of the codes or text 

below: 

 

  > Type II T90 NIDDM 

Type 2 

Type II 

Non insulin dependent 

  
  > Type I T89 IDDM 

Type I 

Insulin dependent 

Juvenile onset 

  
  > Undefined diabetic Diabetic box ticked and not in Type I or II above. 

 

Respiratory   

  > Asthma R96 Asthma 

 

  > COPD  R95 COAD 

COPD 

Chronic Airways Limitation 

Chronic Bronchitis 

Chronic Obstructive Airways Disease 

Chronic Obstructive Pulmonary 

Disease 
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Cardiovascular   

  > CHD * K74 

K75 

K76 

K53 

K54 

coronary insufficiency 

myocardial infarct 

AMI  

angina 

Angioplasty 

Atherosclerotic heart disease 

Blockage Coronary Artery 

Coronary 

CABG 

Heart Attack 

IHD 

Ischaemic Heart Disease 

Myocardial insufficiency 

NSTEMI 

PCTA 

Preinfarction syndrome 

  
  > Myocardial infarction * K75 myocardial infarct 

AMI 

myocardial damage 

NSTEMI 

PCTA  
 

K85 

K86 

K87 

Hypertension 

High Blood Pressure 

High BP 

Hypertensive 

Labile Blood Pressure 

Labile Hypertension 

Malignant Hypertension 

Primary Hypertension 

Essential Hypertension 

Renal Hypertension 

Renovascular Hypertension 

Refractory Hypertension 

  

  > Hypertension 

 

OR, patient is taking an anti-hypertensive medication as per 

MIMS Section 2A 
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  > Heart Failure * K77 cardiac failure 

heart failure 

CCF 

Cor Pulmonale 

Left Ventricular failure 

LHF 

LVF 

Pulmonary Oedema 

RHF 

Right ventricular failure 

RVF 

  
  > Stroke * K90 cerebral haemorrhage 

cerebrovascular accident 

CVA 

Haemorrhage intracerebral 

Haemorrhagic CVA 

Haemorrhagic stroke 

intracerebral bleed 

intracerebral haemorrhage 

Ischaemic stroke 

Lacunar stroke 

Stroke 

Thrombotic Stroke 

  
Mental Health   

  > Depression P76 Depressive 

Depression 

Affective disorder 

  

  

OR, patient is taking an anti-depressant medication as per MIMS 

Section 3D 

 

P01 

P74 

Anxiety   > Anxiety 

 

OR, patient is taking an anxiolytic as per MIMS Section 3B 

 

  > Schizophrenia P72 Schizophreni 

 

 
 

Bone Disease   

  > Osteoporosis L95 osteoporo 

osteopaenia 

osteopenia 

steroid osteopathy 
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  > Osteoarthritis L83 

L84 

L89 

L90 

L91 

L92 

osteoarthritis 

osteoarthrosis 

spondylosis 

  

Other   

T93 Dyslipidaemia 

High cholesterol 

Hypercholesterolaemia 

Hyperlipidaemia 

Hyperlipoproteinaemia 

  

  > Hyperlipidaemia 

 

OR, patient is taking a lipid-lowering agent as per MIMS Section 

2F 

 

 
 

14.1.1. Pregnancy 

 
Pregnancy is not currently collected by Genie.
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14.2. APPENDIX D-2 - MEDICATIONS DATA MAPPINGS (GENIE) 

 
CAT Category Genie Mapping 

 MIMS Class ID Class Name 

405  Alpha-blockers (quinazoline derivatives)   ARB 

838 Alpha-blockers (benzenesulfonamides) 

 

ACE Inhibitors 189 Angiotensin converting enzyme inhibitors 

 

Aspirin 39 Salicylates 

 

Beta Blockers 46 Beta-blockers 

 

54 Calcium channel blocking agents - 

phenylalkylamines   

377 Calcium channel blocking agents - dihydropyridines 

Calcium Antagonists 

501 Calcium channel blocking agents – benzothiazepines 

 

107 Loop diuretics   Diuretics 

162 Thiazide diuretics and related agents 

 

H/glycaemics – 

Insulin 

98 Insulins 

329 Sulfonylureas   

47 Biguanides 

H/glycaemics – Oral 

163 Thiazolidinediones 

 

Lipid M/fying -

Statins 

92 HMG-CoA reductase inhibitors 

Lipid M/fying - 

Other 

165 

166 

168 

169 

170 

172 

1748 

1810 

2428 

2484 

3105 

3818 

4029 

Clofibrate 

Colestipol Hydrochloride 

Gemfibrozil 

Probucol 

Nicotinic acid 

Cholestyramine 

Cerivastatin Sodium 

Avena Sativa Seed 

Avena Sativa Herb Extract 

Avena Sativa Seed Dry 

Policosanol 

Ezetimibe 

Fenofibrate 
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14.3. APPENDIX D-3 - GENERAL DATA MAPPINGS (GENIE) 

 
Demographic Genie Mapping 

Gender Patient Record > Edit Patient 

screen > Sex (M,F,blank) 

Ethnicity Patient Record > Edit Patient 

screen > Misc > Culture > 

Drop down list for Aboriginal / TSI 

DVA Patient Record > Edit Patient 

screen > DVA No. as a value 

Age Patient Record > Edit Patient 

screen > DOB 

Last Visit Patient Record – Main tab - 

Contacts panel > Checks most 

recent date in the list  

Postcode Patient Record > Edit Patient 

screen > Postcode 

 
Allergy Genie Mapping 

 

Patient Record - Main tab – 

Allergies Box 

Allergy Recorded An Allergy Item is present  

 

No Known Allergies The ‘Nil Known’ option is selected 

 

Nothing Recorded No Allergy Items are present and 

the ‘Nil Known’ option is not 

selected 

 

 
Smoking Genie Mapping 

 

Patient Record - Main tab – 

Smoking tick box  

Daily Smoker Smoker = Smoker is ticked  

 

Irregular Smoker NA 

 

Ex Smoker NA 

 

Never Smoked Smoker = Smoker is not ticked 

 

Nothing Recorded NA 
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Measurements 

The following measurements can be found in Genie by opening a Patient Record and 

from the Main tab – Contacts panel viewing the Consultation Record. 

 

BMI 

Lipids: HDL, LDL, Triglycerides 

Creatinine 

HbA1c 

BP 

 

Pap Smear 

The Pap Smear data can be found in Genie on the Patient Record - Main tab. If there 

are smear tests the ‘Last pap’ date will be listed. 

 

Patients marked don’t recall are ignored. 

 

 
Medications - HMR 

Medications can be found on the Patient Record – Main tab. HMR counts all the 

medications listed. 
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14.4. APPENDIX D-4 - DIABETES SIP DATA MAPPINGS (GENIE) 
 

 
Diabetes SIP Item Genie Mapping 

HbA1c Patient Record - Main tab – 

Contacts panel - view the 

Consultation Record 

 

Eye Exam Patient Record – Main tab – 

Contacts panel – presenting 

problem = Referral to 

Ophthalmologist 

OR eye exam 
 

BMI Patient Record - Main tab – 

Contacts panel - view the 

Consultation Record 

 

BP Patient Record - Main tab – 

Contacts panel - view the 

Consultation Record 

 

Foot Exam Patient Record – Main tab – 

Contacts panel – presenting 

problem = Referral to Podiatrist 

OR foot exam 

OR feet exam 

 

Cholesterol Patient Record - Main tab – 

Contacts panel - view the 

Consultation Record 

 

Triglycerides Patient Record - Main tab – 

Contacts panel - view the 

Consultation Record 

 

HDL Patient Record - Main tab – 

Contacts panel - view the 

Consultation Record 

 

Microalbuminuria Patient Record - Main tab – 

Contacts panel - view the 

Consultation Record 

 

Smoking Patient Record - Main tab – 

Smoking tick box 

 

 
 

 
 


